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1 Purpose

This guide describes the configuration procedures required for monitoring performance of MiaRec
recoding server.

2 How it works

MiaRec software provides a number of performance metrics, which can be accessed with Windows
Performance Monitor.

To launch Windows Performance Monitor
e Click Start, click in the Start Search box, type perfmon, and press ENTER.

Performance Monitor provides a visual display of built-in Windows performance counters, either in
real time or as a way to review historical data. You can monitor application and hardware
performance in real time, customize what data you want to collect in logs, define thresholds for
alerts and automatic actions, generate reports, and view past performance data in a variety of
ways.

(=) Performance Monitor = =
(&) File Action View Window Help - &
e #EE=HE
(&) Performance Eﬁ‘ PE-EXF RN ‘
4 | g Monitoring Tools : =
I Performance Monitor . ORI}
4 ‘v Data Collector Sets ULy
4 ‘5 User Defined
@ MiaRec Active Calls
. _my System a0
=) Event Trace Sessions
i Startup Event Trace Sessions
» L Reports
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3 A list of MiaRec performance counters

MiaRec software provide the following performance counters:

3.1 Group “"MiaRec Statistics”

¢ MiaRec Statistics \ Active Recording Calls

The total number of active calls in recording state

¢ MiaRec Statistics \ Active Recording Calls Peak Last 15 min

The peak number of active calls for last 15 minutes

¢ MiaRec Statistics \ Active Recording Calls Peak Today

The peak number of active calls for today

¢ MiaRec Statistics \ Active Recording Calls Peak Yesterday

The peak number of active calls for yesterday

¢ MiaRec Statistics \ Recorded Calls

The total number of recorded calls since application restart (excluding the active calls)

¢ MiaRec Statistics \ New Calls/sec

The number of new calls detected per second

¢ MiaRec Statistics \ Passive Network Packets/sec

The number of passive network packets processed

¢ MiaRec Statistics \ Passive Network Bytes/sec

The number of passive network packets processed in bytes

¢ MiaRec Statistics \ Passive Network Validating Queue Length

The number of passive network packets in queue waiting for validation

¢ MiaRec Statistics \ Passive Network Processing Queue Length

The number of passive network packets in queue waiting for processing

¢ MiaRec Statistics \ Active Recording Calls

The total number of active calls in recording state

¢ MiaRec Statistics \ Active Recording Calls
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The total number of active calls in recording state

¢ MiaRec Statistics \ Active Recording Calls

The total number of active calls in recording state

3.2 Group “"MiaRec Call Statistics Per-State”

This group of performance counters displays statistics per call state

¢ MiaRec Call Statistics Per-State \ Active Calls (Per-State)
The total number of active calls per state.
Supported states:
o RecordedNormal
o RecordedLicenseOveruse

o IgnoredByfFilters

¢ MiaRec Call Statistics Per-State \ Completed Calls (Per-State)
The number of completed calls per-state (excluding the active ones).
Supported states:
o RecordedNormal
o RecordedLicenseOveruse
o IgnoredByfFilters
o DeletedByfFilters

3.3 Group “"MiaRec Call Statistics Per-Protocol”

This group of performance counters displays statistics per voip protocol

¢ MiaRec Call Statistics Per-Protocol \ Active Calls (Per-Protocol)
The number of active calls per protocol (recording and ignored)

Supported protocols:

o Unkown
o SIP

o H.323

o SCCP

o MGCP

o MGCP PRI Backhaul
o SIPREC
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Cisco Built-in-Bridge
Avaya H.323

Avaya TSAPI

Avaya TSAPI Uknown
UNISTIM
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4 View statistics in real-time
1) Launch Performance Monitor:
o Click Start, click in the Start Search box, type perfmon, and press ENTER

2) In the navigation tree, expand Monitoring Tools , and then click Performance Monitor.

®)
() File Action View Window Help

e« | zEE= HE

@P:&rﬁ:rmance ?E'__I'|Eﬂix;>?|'-5|j
4 g Monitoring Tools
Iﬁ Performance Munitur| 1
a | Data Collector Sets
> | 3 User Defined
» _|= Systermn ="
_& Event Trace Sessions
[ Startup Event Trace Ses 207
4 | Reports
5 ﬁ User Defined 70
s ﬁ Systemn
m_
5‘]_
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3) Right-click in the Performance Monitor display area and click Add Counters...

&) Performance Monitor - =
() File Action View Window Help [= &[]
= |
® Performance PE- (XSO0 MM
4 | Monitoring Tools
B& Performance Monitor
= 100
4 [ Data Collector Sets
> [ 3 User Defined
> [y System 907
[ Event Trace Sessions
[ Startup Event Trace Ses 20
4 :ﬁ Reports
B ﬁ User Defined 701
» & System Add Counters,..
1 Save Settings As...
504 Save Image As...
Save Data As...
401 Clear
Zoom To
30_
Show Selected Counters
204 Hide Selected Counters
Scale Selected Counters
10 Remove All Counters ‘/\—/\\
. N~ — /\/M\,__,——\/w\"\m/‘\_,_\/\_v .
3:41:39PM 341 PM  3:42:30PM  3:4240PM 3:42:50 PM  3:43:00 PM 3. 341:38PM
Last | 1470 Average | 2,503 Minimum | 0.000 Maximum 8.232 Duration 1:40
Show Color Scale Counter Instance Parent Object Computer
¥ ——— 10 %ProcessorTime  Total -~ Processorlnformation  WDEV1I
< >
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4) Inside list "Available counters" locate "MiaRec..." counters.
Select one or more counters and click "Add >>" button.

And then click OK.

Different performance counters are available.

On screenshot below two counters are selected:

e Active Recording Calls

e Active Recording Calls Peak Last 15 min

Available counters

Select counters from computer:

<Local computer = W Browse...
MiaRec Call Statistics Per-Protocol ¥ oA
MiaRec Call Statistics Per-5tate A
MiaRec Statistics -

Active Recording Calls

Active Recording Calls Peak Last 15min
Active Recording Calls Peak Today
Active Recording Calls Peak Yesterday

Mew Calls/sec
Paccivae Mahunrk Rvtee fear

Search

[] show dezcription

Add Counters

Added counters

Counter
MiaRec Statistics

Active Recording Calls
Active Recording Cal...

Parent Inst... Computer

Remove <<

Ok Cancel

5) Now you can view statistics from MiaRec software in real-time
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5 Collect historical data for analyzing

It is possible to collect historical data for long period, for example, a few days.
1) Launch Performance Monitor:
o Click Start, click in the Start Search box, type perfmon, and press ENTER

2) In the navigation tree, expand Monitoring Tools , and then right-click Performance Monitor and
select from menu New -> Data Collector Set.

(=) Performance Monitor S
(&) File Action View Window Help [ [=]x]
I EIEE
&) Performance EFEENEY YIEEGELN I
4 | Monitering Tools
B Performance Monitgs
4 [y Data Collector Sets New 4 { Data Collector Set
'_3 User Defined View R
b [ System
= Eyst 5 New Window from Here
Lz, Event Trace Sessions
[ Startup Event Trace Print
4 [ g Reports
b B8, User Defined Properties
b Ji System Help
50,
40_
30_
20
10
3:49:59PM  3:50:10PM  3:50:20PM  3:50:30PM  3:50:40PM  3:50:50PM  3:51:00PM  3:51:10PM  3:49:40 PM 3. 3:49:58PM
Last | 1303 Average | 2415 Minimum | 0.216 Maximum | 7.033 Duration | 1:40
Show Color Scale Counter Instance Parent Object Computer
s
I~ 1.0 Active Recording Calls --- - MiaRec Statistics WDEV1
|_ 1.0 Active Recording Calls Pe... --- - MiaRec Statistics WDEV1
< >
Creates a new item in this container,
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3) Enter name for new data collector set

What would you like to name this data collector set?

MName:
MiaRec Active Calls|
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4) Select location for data files

Where would you like the data to be saved?

Root directory:

| SesystemdriveSe\PerfLogsvadmin'\MiaRec Active Calls
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5) Select newly created Data Collector Set in the left pane.

File | Action View Window Help

Y R EEEN I =T

@ Performance MName Type Output

4 [ @ Monitoring Tools .
em Monitor L Performance Counter
B Performance Monitor ElSysl o9

4 [ Data Collector Sets
4 |3, User Defined
3 E System
[ Event Trace Sessions
[ Startup Event Trace Sessions

3 ﬁ Reports
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6) Right click on System Monitor Log in right pane and select Properties.

(®) File Action View Window Help
e 2EXE = HE

@ Performance Name
4 ﬁ Monitering Tools
B8 Performance Monitor
a I:; Data Collector Sets
4 [:l User Defined
¥ MiaRec Active Calls
b (& System
[ Event Trace Sessions
[ Startup Event Trace
1 [ Reports

System Monitor Log

Deletes the current selection.
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7) Click "Add...” to select the desired performance counters in main window.

8) Change format to Tab separated or Comma Separated. This will allow to open the resulting
file in Excel application for analyzing.

System Monitor Log Properties “

Performance Counters | File

Performance counters:

WMisRec Statistics\Active Recording Calls Add...

WiaRec Statistics\Active Recording Calls Peak La...

Processor Information{_Total)\% Processor Time Remove
Log format:

Tab Separated L

Comma Separated )

Tab Separated LUnits: [ |Maximum samples:
0L —
Birary Seconds ¥ o =

Data source name:

cance ] [ sori
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9) Change sample interval. Recommended interval is 5 minutes.

System Monitor Log Properties

Performance Counters ||=i|.,=_- |

Performance counters:

MiaR ec Statistics\Active Recording Calls
YMiaRec Statistics\Active Recording Calls Peak La...
YProcessor Information{_Total)|3% Processor Time

Add...

REemove

Log format:
| Tab Separated W |
Sample interval: Units: [ Maximum samples:
| 5 %| Minutes v | 0 %
Seconds
Data source name: m_
Hours
Days
Weeks
| Ok | | Cancel | | Apply
Revision 1.1

16



MiaRec Performance Monitoring

10)Now you can start collecting data. Select Start from right-click menu.

() File Action View Window Help

oo EXDczEHm dPuaE

@ Performance Name Type Output
System Monitor Log Performance Counter

4 [ Monitoring Tools
B8 Performance Monitor
4 [ Data Collector Sets
4 [ 3 User Defined
|7 MiaRec Active
» E System | ‘Snrl
EE] Event Trace Sessions
EE] Startup Event Trace Se:
[ Iﬂ Reports

Stop

Save Template...
Data Manager...
Latest Report
New

View

New Window from Here

Delete
Refresh

Start the Data Collector Set.
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11)When you decide to finish collecting log information, select Stop from right-click menu.

®

&) File Action View Window Help

Performance Monitor

4 [ 3 User Defined

b [ System
m Event Trace Se
_ Startup Event |
1 g Reports

<

B8 Performance Monitor
4 [ Data Collector Sets

E MiaRec Actia Calle

Start

Stop

Save Template...

Data Manager...

Latest Report
New ]
View 3

New Window from Here

Refresh
Export List...

Properties

Help

C:\PerfLogs\Admin\MiaRec Active Calls\System Monitor Log.tsv

HEIE
e 20 XEcz Bz pEAd
@ Pfrfurmancg MName Type Output
4 | Monitoring Tools [] System Monitor Log Performance Counter

Stop the Data Collector Set.

12)The resulting data file can be opened for analyzing in Excel application (see next chapter).
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6 Using Excel to analyze collected data

This chapter discusses how to open a *.csv or *.tsv file, apply formatting changes and use Pivot
Chart functionality built into Excel to graph the counters. Finally, we will demonstrate how to use
date filters to drill deeper into specific time ranges, in order to view the graph data in greater
detail.

The screenshots and steps below are for Excel 2013, but they should also work for Excel
2007/2010.

6.1 Open performance counter log file in Excel.
Once file is opened, make some formatting changes:

1) Change the text in the Al cell from “(PDH-CSV 4.0...” to simply “"DateTime”

H - -
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIE

r 3{’ cut Calibri 11 A A T =E Y SwepTe
paste B COPY 7 BIU- "+ HeA-=== ¢35 =
. ¥ Format Painter U-iim -l === &3 [ Merge &
Clipboard M Font I Alignment
Al - fx | (PDH-TSV 4.0) (Pacific Daylight Time)(:
A B C D E F
1 |(PDH—TSV 4.0) (Pa_l\\DEV3\Prc \\DEV3\Mii\\DEV3\MiaRec Statistics\Active Re
2 04:26.7 24 24
3 04:31.7 6.487963 25 25
4 04:36.7 6.644198 27 27
5 04:41.8 7.086898 27 28
6 04:46.8 7.65979 28 29
Al - fx DateTime
A B C D E F
1 |DateTime _|\\DEV3\Prc W\DEV3\Mi:\\DEV3\MiaRec Statistics\Active Re
2 04:26.7 24 24
3 04:31.7 6.487963 25 25
4 04:36.7 6.644198 27 27

2) You can rename other headers in the first row to make them shorter. By default name of each
performance counter contains computer name in the beginning like:

¢ \\MyServer\MiaRec Statistics\Active Recording Calls
Remove computer name and keep only name of performance counter, like:

e MiaRec Active Recording Calls
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3) Remove row 2 by right clicking on the row number -> “Delete.” This row, containing the first
row of data, is typically a junk row.

o £ ="-8/2014 1:0.
Calibri ~/111 - A A § - %
B I = & - .. €000 ——
T e 'é'__.f,. 020 . \\DEV3\Mia
2 ’ nA.E 7 24 24
3 b Cut 487963 25 25
4 B copy 644198 27 27
5 | [y Paste Options: 086898 27 28
6 %‘ e 7.65979 28 29
7 2 = 383799 29 29
8 Paste Special... 217107 31 31
9 Insert 441005 29 31
10 729651 28 31
Delete
11 594285 28 31
']2 Clear Contents 342167 29 31

4) Highlight the entire "A” column by clicking on the column header, then right-click anywhere in
the column -> Format Cells...

Al

A
DateTime

N RWNoOoOw®ONOUAWN =

3%
04:31
04:3€ =
04:41
04:4€
04:51
04:5€
05:01
05:0€
05:11
05:1€
05:21
05:2€
05:31
05:3€

nc.a1 7l

I = ¢

R r
Cut
Copy
Paste Options:
=
> E

Paste Special...

Insert
Delete

Clear Contents

Format Cells...

Column Width...

Hide
Unhide

C 2anna“

BA -l

Mi:\!
25
27
27
28
29
31
29
28
28
29
30
28
26
27

27
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5) On the Number tab, select the “Date” category and the "3/14/01 1:30 PM” type, and click
OK.

Number | Alignment | Font | Border | Fill | Protection ‘

Category:

General Sample
Number DateTime
Currency
Accounting
Date

Time

Type:
Mar-12
March-12

. March 14, 2012
Fraction

Scientific 3/14/12 1:30 PM

Toxt 3/14/1213:30

Special qu
Custom

Percentage

Locale (location):

English (United States)

Date formats display date and time serial numbers as date values. Date formats that begin with an
asterisk (*) respond to changes in regional date and time settings that are specified for the
operating system. Formats without an asterisk are not affected by operating system settings.
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6.2 Create Pivot Chart
1) Select the top left cell (A1)

2) From “Insert” menu click on “PivotChart” button and select “PivotChart” from drop down

menu.
HS-&-- System Monitor Log20140918130426.tsv [Read-Only] - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW LOAD TEST
[T l!‘ - =~ «ﬁ— - —_
[ ; .'_ IE 3
T B o o] yip NECIERN -
PivotTable Recommended Table lllustrations Apps Recommended Dl PivotChart Map Sparklines Filte
PivotTables - - Charts i - -
Tables Charts I PivotChart
Al T fx DateTime i PivotChart & PivotTable

3) You will see dialog “Create PivotChart”. Click OK.

Choose the data that you want to analyze

(®) Select a table or range

Table/Range: |'System Monitor Log2014091813042'1$A$1:$D$5

O Use an external data source
Choose Connection...
Connection name:
Choose where you want the PivotChart to be placed
@ New Worksheet

O Existing Worksheet

Location:

Choose whether you want to analyze multiple tables

Add this data to the Data Model
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4) On the right pane “PivotChart Fields” select DateTime field and those performance counters,
which you would like to see on graph.

Make sure that "DateTime” field appear in "AXIS"” pane in right bottom corner and other
fields appear in "X VALUES" pane. If not, then drag fields between panes.

v [Read-Only] - Excel PIVOTCHART TOOLS ?7H - 0O X
VIEW LOAD TEST ACROBAT TEAM ANALYZE DESIGN FORMAT Sign in

& [ gk IF 5 = N

Refresh Change Data Clear Move Fields, tems, OLAP Relationships | Field  Field

1S - Source ~ v Chart &Sets~ Tools List Buttons ~
Data Actions Calculations Show/Hide ~
v
E F G H | J K - . . -
— x
PivotChart Fields
. . . Choose fields to add to
Sum of MiaRec Active Recording Calls X
report:
Total v| DateTime
35 [ 1% Processor Time
30 I MiaRec Active Recording Calls
25 . . .
20 [ I MiaRec Active Recording Calls ...
15
10
5
0 M Total
SS33323232333232332S=222=2=2=2=2=2=2=22=22
[+ W = W « A o WA« TR o NN s U o WY« TN U T o T o T o T o T o T o O o o N T - Y - T < .
< ST TN NN NWMWMWY WY WYY WONSNSMNSMNMNINSONON 0
O 0000000000000 O0ODO0OO0CO0OO0OO0OO0OO0O0OO0OOoO
B R R B I T R R R B B B B I B = - G B QP R e
R T T i S G S i i B B s S i i i S Y
L T T T T T O IO R B O O O B O O IO O O O O O I B o
e T T e T e T e e e T e e e - e e T e e T e e e
00 00 00 00 00 ©0 ©0 00 00 CO €O OO0 00 CO CO 00 00 ©O ©0 ©0 00 ©0 o0 o0 ©0
T T T T T T O O O O IO O O O IO O o IO O o O O O O I B o
e e e s
[+ e DI« W« ) W« ) o 3 N« )« ) JOE « ) e 3 e ) T NN e w3 N o 2 W o ) W T o ) N e ) I o) M ) I o A D« ) N« ) I o))
DateTime -~

Drag fields between areas below:

Y FILTERS Il LEGEND (SE...

= AXIS (CATE.. | > VALUES

DateTime ¥ H Sum of Mi... ¥
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5) Right-click inside chart area and select "Change Chart Type...”

4 — = = |Chart Area
§ . . Fill  Outline
Sum of MiaRec Active Recording Calls
e
Total )
@ Refresh Data
¢
C
35
25 =
20 EBgopy v
15 Ty Paste Options:
10
5 i
0 il
S S2SS222222222222222222222 .k
oo oo focOo oo ooOo o000 oo o oo oo o (s ResettoMgtchSter
S S S N WWLWWLWWWWWWWMNSMNSMSNSMSSOW
eeeeeeeEeeeeeeaaAeae e QY
Aot - - - - S - A S - A S S A S S A - A S S A -
e T e T O O e O e O e O T O O o O e O B B
3 o5 0 00 00 03 03 63 00 03 O3 63 03 O3 00 03 O3 O 00 & O O & ¢
i i e e e e e R B i b B |l | ChaHQEChartT)lPe---
B e Tt e e e e e e e e e e e e i i, i Sy
Lo O I NI DN N P D e e s~ N U« N« N« N Y D e D e
I Save as Template...
DateTime -
A ~ Select Data... C
[A] na —l
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6) Select "Line” as a chart type.

All Charts

iy Recent
[ Templates

il Column

Pie

Bar

Area

XY (Scatter)
Stock

Surface

Radar RN ATAS
S

Combo

FXBESNG

Cancel
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7) Click OK. Now you will have graph showing changes in performance counters in time.

Sum of MiaRec Active Recording Calls

Total

35

30
25

20
15

10

Total

Nd 80T ¥T/8T/6
Nd 80T ¥T/81/6
INd 80'T ¥1/81/6
Nd 80T ¥T/81/6
Nd LO'T ¥T/8T/6
Nd LOT ¥T/8T/6
Nd £O'T ¥T/81/6
Nd £0'T ¥T/8T/6
Wd LO'T ¥T/8T/6
Nd LO'T ¥T/8T/6
INd 90:T ¥T/81/6
Nd 90T ¥T/81/6
INd 90T ¥T/81/6
INd 90:T ¥T/81/6
INd 90:T ¥T/81/6
Nd 90T ¥T/81/6
Nd SO'T ¥T/81/6
Nd SO'T ¥T/81/6
INd SO'T ¥T/81/6
INd SO'T ¥T/81/6
INd 50T ¥T/81/6
Nd GO'T ¥T/81/6
Nd vO'T ¥T/81/6
Nd 70T ¥1/81/6
Wd vO'T ¥T/81/6

-

DateTime

26
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6.3 Drilling deeper into specific time ranges.

1) To see on graph values filtered by date range, click on "DataTime"” button in left bottom
corner of graph and select "Date Filters” -> "Between...”

14 | 20
15
16 | 15
17
18 | 10
19 _/\/\__V\
20 5
21
22| ©
= =2 =2 =2 2z =2 2
23 e
o o o o o o o o
P A s R .
25 e - - - - - T -
©Q © © 0 00 © o o0
6 SEE§8884
27 |pateTime - |
%l Sort Oldest to Newest
El Sort Newest to Oldest
More Sort Options...
Date Filters »
Value Filters 4
Search jo)
¥ (Select All R
~V19/18/14 1:04 PM
¥19/18/14 1:04 PM
~¥19/18/14 1:04 PM y
oK Cancel

PAGE 25 OF 25 784 WORDS [[® ENGLISH (UNITED

@
Equals...
Before...
After...
Between...
Tomorrow
Today
Yesterday
Next Week
This Week
Last Week
Next Month
This Month I
Last Month
Next Quarter
This Quarter
Last Quarter
Next Year
This Year
Last Year
Year to Date
All Dates in the Period »

Custom Filter... I
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2) And specify particular date range:

Show items for which the date

D Whole Days

Cancel

3) Now the graph will show values for specific date range.
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